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Chương 1 
Tổng quan về PICkit 2 Programmer/Debugger 

 
1.1 Giới thiệu: 
PICKit2 Programmer / Debugger là sản phẩm của Microchip được phát triển trong 
thời gian gần đây. Điểm đặc biệt của PICKit 2 là chi phí thấp. Có khả năng nạp / 
gỡ rối hầu hết các chip PIC và EEPROM, tốc độ cực nhanh và tiện dụng. có thể 
nạp và gỡ lỗi trực tiếp trong MPLAB IDE hoặc nạp bằng phần mềm PICKit 2 
Programmer Application. Ngoài ra PICkit 2 còn có thể sử dụng như một thiết bị 
đầu cuối truyền dữ liệu với PC qua chức năng UART Tool và Logic Tool 
Analyzer. Có thể tóm tắt các tính năng của PICkit 2 như sau: 

• Giao tiếp PC qua cổng USB, không cần cài đặt driver (tương tự như mouse, 
keyboard USB của PC), độ ổn định rất cao, không bị lỗi. 

• Giao diện windows nổi bật, supports the Windows Vista 64-bit OS 
• Tốc độ nạp/gỡ rối cực nhanh. Chức năng nạp/gỡ lỗi, UART tool và Logic 

Tool Analyzer 
• Support đầy đủ baseline (PIC10F, PIC12F5xx, PIC16F5xx), midrange 

(PIC12F6xx, PIC16F), PIC18F, PIC24, dsPIC30, dsPIC33, and PIC32 
families of 8-bit, 16-bit, and 32-bit microcontrollers, và một số sản phẩm 
Serial Eprom của Microchip 

• Tự động cập nhật Firmware khi có phiên bản mới 
• Có chức năng Programmer-To-Go – nạp không cần giao tiếp PC 
• Chip mới (New device) có thể được bổ sung bằng việc cập nhật phần mềm. 

Phần mềm gần đây nhất thì sẵn có trên website của Microchip 
www.microchip.com. 

 

 
 

Hình 1: PICkit 2 phiên bản đầy đủ 

 
Hình 2: PICkit 2 Phiên bản rút gọn 
(Chỉ sử dụng cho PIC MCU có VCC 
= 5V không support 3V3 ) 
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Hình 1: Là một PICkit 2 đầy đủ tính năng tương tự như sản phẩm cùng tên của 
Microchip, được Thiên Minh Electronic Solutions (TMe) – www.tme.vn phát triển 
và sản xuất tại Việt nam, mọi linh kiện, PCB và thiết kế đều có chất lượng cao. 
Sản phẩm được bảo hành miễn phí 1 năm. 
 
Hình 2: Là PICkit 2 rút gọn, Do phần cứng đơn giản nên chỉ support các PIC 
MCU có VCC = 5V. Nó thì giá rẻ phù hợp với các đối tượng Sinh viên và người 
dùng nghiệp dư. Bảo hành miễn phí 1 năm. 
 
Sau một thời gian dài bán 2 sản phẩm PICKIT2 như giới thiệu ở trên được khách 
hàng tin dùng và cũng từ góp ý, nhu cầu sử dụng của khách hàng, TMe phát triển 
thêm PICKIT2-PLUS là Phiên bản rút gọn (VCC cố định 5V) Có gắn ZIF Socket, 
Có thể nạp trực tiếp trên ZIF Socket các loại PIC10F, 12F, 16F, 18F và nạp qua 
ICSP cho dsPIC30F 40/28/20 PIN….và tấc cả các loại PIC mà phần mềm support. 
Đường ICSP này rất tiện dụng trong việc nạp các chip on-board. 
 

 
 
PICKIT2-PLUS sử dụng một Jumper để lựa chọn VPP cho các loại PIC10F, 12F, 
16F, 18F tương ứng được nạp trên ZIF Socket, các vị trí và chiều gắn Chip được 
chú thích kỹ trên phần cứng. Bạn phải chú ý lựa chọn Jumper cho phù hợp với loại 
Chip cần nạp, tránh trường hợp gắn nhầm làm hư hỏng Chip. 
 
Chú ý: PICKIT2-PLUS hiện tại không nạp được cho các dòng dsPIC30F 40/28/20 
PIN …trên ZIP Socket, Các loại này phải nạp qua đường ICSP.  
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Cách Gắn PIC và lựa chọn Jumper trên ZIP Socket: 
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1.2 Ứng dụng PICkit2 cho việc nạp chương trình: 
PICKit 2 programmer cho phép bạn nạp chương trình (Programmer) cho tất cả các 
PIC được hỗ trợ liệt kê trong file PICKit2 Readme. Giao diện lập trình có thể 
giống như hình 2. Những chức năng điều khiển  được liệt kê trong những khu vực 
sau: 

 
          Hình 2: PICKit 2 Programmer Application 

 

1.2.1 Menu Bar 
Menu bar cho phép chọn lựa những chức năng khác nhau. Tóm lược những chức 
năng sau: 

File 
• Import HEX: Nhập một file HEX để nạp. File HEX hỗ trợ dạng 

INHX32 
• Export HEX: Xuất thành một file HEX đọc từ chip. File HEX được 

tạo ra cũng trong dạng INHX32 

Menu Bar 

Device config 

Status window 

Progess Bar 

Device VDD 

Memory source 

Program memory 

EEPROM Data memory 
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• Flie History: liệt kê danh sách 4 file HEX gần nhất được mở ra cùng 
với đường dẫn của nó. Những file HEX gần đây này có thể được 
chọn để nhập nhanh. Ghi chú: History mới đầu cài đặt phần mềm 
mặc nhiên còn trống cho đến khi có lệnh Import một file HEX. 

• Exit: Thoát khỏi chương trình. 
 
Device Family 
Lựa chọn một nhóm chip để tìm kiếm một chip có trong nhóm đó 
Một số nhóm chip thì không thể Auto-detected (ví dụ như Baseline) sẽ hiện 
ra một hộp kéo xuống , trong đó chứa những chip cần lựa chọn. 

 
Programmer 

• Read Device :Đọc nội dung chip như program memory, data 
EEPROMmemory, ID locations và Configuration bits. 

• Write device : Nạp nội dung  cho chip như program memory, data 
EEPROMmemory, ID locations và Configuration bits. 

• Verify : so sánh nội dung  như program memory, data 
EEPROMmemory, ID locations và Configuration bits đọc từ MCU 
đích với nội dung file HEX được import 

• Erase : Xóa toàn bộ nội dung chip 
• Blank Check: kiểm tra một chip trống hay không 
• Verify on Write: nếu được đánh dấu (check) Chip sẽ thực hiện xác 

minh (so sánh lại) ngay sau khi nạp ( đề nghị), nếu không đánh dấu 
thì nó chỉ nạp mà không xác minh quá trình. 

• Hold Device in Reset : nếu được đánh dấu (check) chân MCRL\ 
(Vpp) sẽ được chốt ở mức thấp (khẳng định). Nếu không đánh dấu, 
chân này sẽ được thả tự do (Tri-Staed), cho phép một Pull-up bên 
ngoài đưa chip ra khỏi sự Reset 

• Write on PICkit Button: khi được đánh dấu một thao tác nạp (write) 
sẽ được thực hiện khi nhấn nút Push button trên PICKit 2 (nút Push 
button  không sử dụng cho phiên bản này) 

Tools 
• Enable code Protect: Cho phép bảo vệ mã của Micocontroller khi có 

thao tác nạp sau khi chọn chức năng này 
Ghi chú: để xóa bỏ mã bảo vệ mọi bộ nhớ chip phải được xóa bỏ và 
nạp lại. 

• Enable code Protect: Cho phép bảo vệ dữ liệu của Micocontroller có 
dữ liệu EEPROM khi có thao tác nạp sau này 
Ghi chú: để xóa bỏ mã bảo vệ mọi bộ nhớ chip phải được xóa bỏ và 
nạp lại. 

• Set OSCCAL: cho phép thay đổi giá trị OSCCAL của Chip. Vị trí 
được lưu vào phần cuối cùng của bộ nhớ chương trình 
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• Taget VDD soucer:  
- Auto-Detect: PICKit2 sẽ tự phát hiện ra Chip đích có cấp nguồn 
hay cần phải cấp nguồn bởi PICKit 2 Programmer mỗi khi có 
thao tác 
Lưu ý: Phiên bản “Only 5V” chỉ sử dụng nguồn cố định VDD = 
5V cung cấp qua USB 

- Force PICkit 2: PICKit 2 sẽ luôn luôn thử cấp nguồn đến Chip 
đích 

- Force target: PICKit 2 sẽ luôn luôn coi Chip đích đã được cấp 
nguồn sẵn 

 
• Calibrate VDD & Set Unit ID: Mở ra một wizard từng bước người 

dùng định cỡ Điện áp PICKit 2 VDD, ví vậy nó chính xác hơn. Và 
để chọn việc gán một đơn vị ID để dễ dàng phân biệt các PICKit 2 
khác nhau 

• Use VPP First Program Entry: Khi mục này được check, nó cho 
phép PICkit 2 nối tới và nạp với những cấu hình và mã có chân giao 
tiếp  ICSP cản trở PICkit 2 phát hiện ra chúng. Việc sử dụng đặc tính 
này yêu cầu PICKit 2 phải sử dụng nguồn ngoài 

• Fast programming: Khi check vào mục này PICKit 2 sẽ thử nạp cho 
Chip càng nhanh càng tốt. Khi không được check PICKit 2 sẽ làm 
chậm tốc độ giao tiếp ICSP xuống. Điều này thì có ích với các 
đường ICSP có tải. 

• Check Communication: Xác nhận giao tiếp USB với PICKit 2 và 
giao tiếp ICSP với một Chip đích bởi việc xác định ID của Chip đó. 

• UART Tool…: Đặt PICKit2 vào Mode UART giống như một thiết bị 
đầu cuối để giao tiếp với một chương trình Chip PIC MCU thông 
qua những chân USART 

• Troubleshoot…: (dò lỗi) – Mở ra một wizard để giúp đỡ việc dò lỗi 
kết nối từ PICKit 2 đến Chip đích. Đây là một chức năng hữu ích 
nhất bất cứ khi nào PICKit 2 không phát hiện ra Chip đích 

• Download PICkit 2 Programmer Operating System: Thực hiện việc 
tải xuống (cập nhật) PICKit 2 Operating System (Firmware). 

 
Help 

• PICkit2 User.s Guide: Giới thiệu và Hướng dẫn sử dụng PICKit2 
file PDF (yêu cầu phải cài đặt phần mềm Adobe Reader) 

• 44-Pin Demo Board Guide: Giới thiệu và Hướng dẫn sử dụng 44-
Pin Demo Board file PDF (yêu cầu phải cài đặt phần mềm Adobe 
Reader) 
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• LPC Demo Board Guide: Giới thiệu và Hướng dẫn sử dụng Low Pin 
Count Demo Board PDF (yêu cầu phải cài đặt phần mềm Adobe 
Reader). 

• PICkit 2 Programmer on the web: mở  www.microchip.com/pickit2 
trong trình duyệt web mặc định. 

• Readme: mở file PICkit 2 Readme.txt. File này chứa thông tin về 
phiên bản mới, Chip được hỗ trợ và cách kết nối với thiết bị đích 
(Chip) 

• About: Mở một hội thoại với PICkit 2 Programmer application 
version, device file version và firmware version. 

 
1.2.2 Device configuration 

Device configuration là cửa sổ trình bày Chip, User ID, Configuration 
Word Và Checksum. Nó cũng trình bày OSCCAL và BanGap cho những 
chip có những đặc tính đó. 
 
Để sử dụng cho baseline (12-bit core) devices, serial EEPROM devices, và 
KeeLoq® HCS devices bạn phải lựa chọn device từ Chip từ Device drop-
down menu. Do những chip này không có ID 
 
Tất cả chip từ nhóm khác sẽ được phát hiện ra ID và tên chip được trình 
bày trên hàng Device 

 
1.2.3  Status Window 

Status Window trình bày dạng text tình trạng của những thao tác đang hoạt 
động. Nếu Một thao tác  thành công, cửa sổ tình trạng sẽ trình bày một nền 
xanh lục. Nếu một thao tác thất bại, cửa sổ tình trạng sẽ trình bày màu đỏ. 
Nếu một thao tác báo động một nhắc nhở, ý định cửa sổ tình trạng trên màn 
hình có màu vàng 

 
1.2.4  Progress Bar 

Là một thanh trình bày tiến độ của một thao tác. 
 

1.2.5 Device VDD 
PICKit 2 VDD có thể bật ON và OFF bằng cách click vào ô checkbox 
“ON” điện áp có thể được đặt bằng việc gõ trực tiếp hoặc nhấn vào dấu 
lên/xuống để điều chỉnh 0.1V mỗi lần giá trị maximun và ninimum là 
những điện áp sẽ cho phép thay đổi tùy thuộc và Chip đích 
Nếu ON  trên checkbox không được chọn, PICkit 2 sẽ tự động bật VDD tại 
giá trị được set trong bất kỳ lúc nào có thao tác lập trình 
 



PICKIT2 User’s Manual                                                                    Trang 9 of 50 
 
 

 

 

 

Thien Minh Electronic Solutions Co.Ltd (TMe) www.tme.vn 
 

 
Hình 3 – PICKIT 2 SUPPLIED VDD 

 
Nếu Chip đích có cấp nguồn của mình, thì PICkit 2 sẽ hiển thị điện áp mà 
nó phát hiện ra trong ô bên phải, đồng thời nó sẽ chuyển sang màu xám để 
ngăn ngừa sự thay đổi. 
 
Khi ô checkbox được cho phép check, và việc kích vào checkbox sẽ cập 
nhật phát hiện ra giá trị điện áp VDD. Nếu Target VDD>Auto-Detect được 
lựa chọn, việc kích vào checkbox sẽ trở lại kiểu VDD trước đó PICkit 2 
được cung cấp VDD nếu có sự cấp nguồn từ Chip đích thì nó không còn 
được phát hiện ra. 

 

 
Hình 4 – TARGET SUPPLIED VDD 

 
Device /MCLR State 
/MCLR checkbox được trình bày trên hình 3 và 4 có chức năng giống như 
menu chọn Programmer>Hold Device in Reset Khi check vào ô này Chip 
đích sẽ được giữ không cho Reset lại. Khi Không được check, Mạch đích 
được cho phép tới kéo MCLR tới VDD để thả tự do cho Chip được Reset. 
Chức năng này có thể được dùng để cản trở một Chip thực hiện mã trước và 
sau khi lập trình 
 
GHI CHÚ: Nếu Chip đích cho phép chân MCLR sẽ được cấu hình như 
một input port, và nó được cấu hình như vậy, PICkit 2 sẽ không có khả 
năng để giữ Chip Reset lại 

 
1.2.6 Memory Source 

Source bar trình bày dữ liệu nguồn của Chip hiện tại được tải vào. Nếu đọc 
từ một file HEX, nó sẽ trình bày tên file HEX. Nếu được đọc từ một chip, 
nó sẽ trình bày tên chip. Nếu Không có gì ( chip trắng/ Xóa) màn hình 
buffers sẽ không có dữ liệu, và nó sẽ trình bày soạn thảo một bộ nhớ 
chương trình hay bộ nhớ dữ liệu EEPROM được soạn thảo trong cửa sổ. 
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1.2.7 Program Memory 
Mã Chương trình có thể được tải vào trong PICkit 2 bằng cách chọn File > 
Import HEX để nhập một file HEX hoặc bằng cách click nút Read để đọc 
nội dung từ chip.Nguồn gốc của mã được trình bày trong Source block. Cửa 
sổ hiển thị bộ nhớ chương trình trình bày hệ HEXadecimal. Mã có thể được 
soạn thảo trong cửa sổ này. 
 
Ô checkbox bên cạnh cửa sổ program Memory chỉ sẵn sàng trên những 
chip có bộ nhớ dữ liệu EEPROM. Nếu ô này được check thì Program 
Memory, User IDs, và Configuration Words được nạp vào (wirite to) , đọc 
(read from) và xác minh (verified) trên chip. Nếu ô này không được check 
thì Program Memory, User IDs, và Configuration Words sẽ được xóa bỏ 
hay biến đổi trong thời gian nạp chip và sẽ không được read hay verified. 
Checkbox không ảnh hưởng đến thao tác xóa (Erase) hay kiểm tra chip 
trống (Blank Check). Cả 2 ô checkbox memory cũng không thể bỏ đi cùng 
một lúc 
 
Để hỗ trợ cho serial EEPROM devices nội dung chip được trình bày trong 
cửa sổ Program Memory chứ không phải ở cửa số Data EEPROM Memory 
để dễ dàng nhìn thấy hơn do vùng trình bày lớn hơn 

 
1.2.8 Data EEPROM Memory 

Tương tự như Program Memory ở trên, data EEPROM code có thể được tải 
vào trong vùng làm việc của PICkit2 bởi lựa chọn File>Import HEX để 
nhập một file HEX hoặc bằng cách click nút Read để đọc nội dung từ chip. 
Nguồn gốc của mã được trình bày trong Source block. Cửa sổ hiển thị Data 
EEPROM Memory trình bày hệ Hexadecimal. Mã có thể được soạn thảo 
trong cửa sổ này. 
 
Ô checkbox bên cạnh cửa sổ EEPROM Data được viết Write, Read và 
Verified. Nếu ô này được check, thì Chip EEPROM sẽ được ghi đè lên với 
dữ liệu cửa sổ. Nếu ô này không được check, thì EEPROM sẽ không được 
xóa bỏ hay biến đổi trong thời gian có thao tác Write chip. Checkbox không 
ảnh hưởng đến thao tác xóa (Erase) hay kiểm tra chip trống (Blank Check). 
Cả 2 ô checkbox memory cũng không thể bỏ đi cùng một lúc 
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Chương 2 
Bắt Đầu Làm Việc Với PICKit 2 

 
2.1 Cài đặt phần cứng PICKit 2 

 
Để cài đặt phần cứng PICKit 2: 

• Cắm một đầu của cable USB đến đầu nối USB của PICKit 2, cắm 
đầu còn lại của cable USB vào cổng USB của PC 

• Kết nối PICkit 2 với board mạch đích qua một dây 5-pin (ICSP), 
board đích có thể là Adapter ICSP hay bất kỳ bo mạch PIC nào có 
trang bị đầu nối 5-pin ICSP 

• Khi gắn PICKit 2 vào cổng USB khuyến cáo nên ngắt board mạch 
đích ra khỏi PICKit 2 trước. tương tự khi khởi động hoặc reset lại 
PC phải bảo đảm ngắt PICKit 2 ra khỏi PC. 

 
2.2 Cài đặt và chạy chương trình PICKit 2 Programmer 
Chèn đĩa CD-ROM kèm theo PICkit 2 vào ổ đĩa CD-ROM. Trong vài giây, đĩa 
CD sẽ chạy tự động và màn hình sẽ được trình bày. Chọn menu tương ứng để cài 
đặt phần mềm PICKit 2. 
 
Nếu màn hình giới thiệu không xuất hiện, chuyển tới thư mục đĩa CD-ROM và mở 
file index.htm . 
 
Sau khi cài đặt (install), chạy chương trình PICkit 2 programmer bằng cách chọn 
Start>Programs>Microchip> PICkit 2. Hoặc double click biểu tượng PICKit 2 
trên desktop Giao diện Programming được hình lên có thể giống như hình 5. Một 
danh sách  những đặc tính và chức năng của nó có thể tìm thấy ở hình 2. 
 . 
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Hình 5 - PICkit. 2 PROGRAMMING APPLICATION 

 
2.3 Kết Nối Tới Chip 
PICkit 2 được kết nối tới Chip qua đường ICSP, để PICKit 2 nhận ra Chip bạn cần 
phải nối chúng theo đúng các chân VPP, VDD, GND, PGD, PGC 
 
Khi phần mềm PICkit 2 được mở đầu tiên, nó sẽ thử nhận ra kết nối với chip bởi 
việc hiển thị  ID của chip và hiển thị trong cửa sổ Cấu hình hình 6. 
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HÌNH 6 Xác Nhận Chip 

 
Nếu Chip đích không được xác định, kiểm tra nguồn cung cấp cho nó và những 
kết nối ICSP của chip hoặc thay đổi Chip. 
Vào bất kỳ lúc nào một nhóm chip có thể chọn để tìm kiếm kết nối tới một chip 
trong nhóm đó. Để nối tới một Chip một lần ứng dụng đã đang chạy, chọn lựa 
nhóm Chip bởi việc kích vào menu Device Family như Hình 7. 
 

 
  

Hình 7. SELECT DEVICE FAMILY 
 

Nếu baseline (12-bit core),KEELOQ®HCS hoặc EEPROMs device family được 
lựa chọn, bạn phải lựa chọn Chip đặc biệt từ device drop-down box như Hình 8 
được đưa vào. Những Chip này không có ID Chip và không hỗ trợ sự dò tìm tự 
động. 
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Nhắc nhở 
Bảo đảm rằng baseline đã được lựa chọn đúng. Những Chip này không chứa ID 
Chip để xác nhận sự chọn lọc Chip. Chọn Baseline sai có thể gây ra sự xóa giá trị 
OSCCAL được cất giữ trong ô nhớ cuối cùng. 

 
 

Hình 8. SELECT BASELINE FLASH DEVICE 
 
2.4 Lựa Chọn Nguồn Đích 
PICKit 2 có thể cung cấp nguồn cho Chip đích hoặc Chip đích có thể sử dụng 
nguồn ngoài 
 

2.4.1 Cấp nguồn từ PICkit 2 cho mạch đích: 
Nếu bạn đang cấp nguồn cho board mạch đích từ PICkit 2, mà không gắn 
nguồn cho nó hoặc PICkit 2 sẽ cảm thấy nó và không đưa cho bạn tùy chọn 
để sử dụng nguồn từ PICkit 2. để một board mạch đích không dùng đến 
nguồn ngoài, bạn sẽ nhìn thấy những tùy chọn được trình bày trong Hình 9. 

 

 
Hình 9. Cho phép Cấp nguồn Từ PICkit  2 

 
Để cho phép cấp nguồn tới Chip đích, Đánh dấu check vào VDD PICkit 2 
“On”. Như đã thấy. Sự thiết đặt mặc định là Off, thí dụ, checkbox không 
được đánh dấu 

Voltage 
Box 
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Ghi chú:Nếu sự cấp nguồn đích không được phát hiện ra, PICkit 2 sẽ luôn 
luôn cấp nguồn tới mạch đích trong thời gian lập trình, bất chấp trạng thái 
checkbox của VDD PICkit 2 “On”. 
Điện áp được cung cấp tới mạch đích có thể được điều chỉnh trước đây hay 
sau khi chọn nguồn được điều chỉnh trong VDD PICkit 2 Voltage box 
(Hình 9). Nếu một sự  ngắn mạch hay quá dòng được phát hiện ra trên 
Programmer-supplied VDD, thì bạn sẽ nhận được một lỗi và VDD sẽ tự 
động ngắt. Xem hình 10 
 
Nhắc nhở: Dòng giới hạn của cổng USB được set đến 100 mA, nếu dòng 
của mạch đích + dòng của PICKit 2 vượt quá dòng giới hạn này thì cổng 
USB có thể bị ngắt. Mạch đích có thể sử dụng nguồn ngoài nếu nó yêu cầu 
dòng cao hơn. 

 
Hình 10. VDD Error 

 
Tránh bị lỗi quá tải, khuyến cáo nên giữ mạch đích tiêu thụ ở dưới 25 mA. 
VDD có điện dung lớn cũng cần phải được tránh  vì nó có thể làm chậm sự 
lên của VDD. VDD được cho phép thời gian lên là 500 µs hay ít hơn. 
 
2.4.2 Cấp nguồn ngoài cho mạch đích: 
Thiết bị đích có thể đươc cung cấp bởi nguồn ngoài, theo mặc định PICKit 
2 có thể tự động phát hiện nguồn cung cấp từ một board mạch ngoài. Tiêu 
đề “VDD PICkit 2” có thể thay đổi thanh “VDD taget”, checkbox “On” 
được thay đổi bằng một checkbox có tên “Check”, và điện áp VDD được 
phát hiện ra là cái hộp điện áp được trình bày trong voltage Box ở ngoài có 
màu xám như trong Hình 11 
Click vào “Check”, checkbox sẽ cập nhật VDD phát hiện được và hiển thị 
nó trong Voltage Box, nếu điện áp VDD không được phát hiện ra khi click 
vào checkbox thì PICkit 2 sẽ trở về cấp ngôu VDD chi thiết bị đích 
 

 
Hình 11 EXTERNALLY POWERED TARGET 
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Ghi chú: 
VDD ngoài cực đại  có thể sử dụng với PICkit 2 là 5.0 V. 
VDD ngoài cực tiểu có thể sử dụng với PICkit 2 là 2.5 V. 
 

2.5 Nhập Một File HEX 
Để nhập một chương trình đã được biên dịch (HEX file) và nạp nó vào thiết bị 
đích (chip) , chọn File>Import HEX được nhìn thấy như trong hình 12 
 

 
Hình 12. IMPORT HEX FILE 

 
Đi đến thư mục chứa file HEX cần nhập, chọn nó và click Open, code sẽ hiển thị 
trong cửa sổ Program Memory và EEPROM Data. Tên và đường dẫn của file HEX 
được hiển thị trong Source block bên trên cửa sổ Program Memory 
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Hình 13. EXAMPLE HEX FILE IMPORTED 
PICkit 2 Programmer sẽ cảnh báo bạn nếu file HEX không chứa đựng bất kỳ 
Configuration Words nào. Bạn phải xem lại liệu file HEX này cấu hình của nó có 
phù hợp với chip bạn đang muốn nạp vào hay không 
 
Bạn cũng sẽ được cảnh báo nếu nhập một file HEX có kích thước lớn hơn so với 
kích thước bộ nhớ của chip. Bất kỳ dữ liệu nào không định vị được trong ô nhớ 
chip thì sẽ không thể được nhập vào 
 
2.6 Nạp Chương trình vào Thiết bị (Chip) 
Sau khi một chi đã được lựa chọn và một file HEX đã được nhập vào, chip đích có 
thể được nạp vào bằng việc kích nút Write (Hình 14). Chip sẽ được xóa bỏ và 
được nạp với mã HEX trước đó được nhập vào. Việc kết hợp xóa trong thao tác 
nạp gọi là phương pháp xóa gộp. 
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Ghi chú: Nếu có Code Protect, Data Protect, Write Protect, hoặc Read Protect 
configuration bits hiện thời được set trong chip, phương pháp xóa gộp có thể 
không thành công. 
 

 
Hình 14. NÚT WRITE 

 
Tình trạng của thao tác nạp được trình bày trong Staust Bar được định vị ở bên 
dưới của cửa sổ Device configuration. Nếu nạp thành công, Status Bar trở về màu 
xanh lục và màn hiển thị hình “Programming Successful” (Lập trình Thành công), 
như được thấy trong hình 15. 
 

 
Hình 15. Tình trạng nạp thành công 

 
Nếu nạp thất bại, status bar chuyển sang màu  đỏ và “Programming Failed”, như 
được cho thấy trong Hình 16. Lỗi này chỉ báo rằng chuổi dữ liệu bị hư hỏng trong 
thời gian lập trình. Nếu lỗi này hiển thị, thử  nạp chương trình tới thiết bị lần nữa. 
Nếu lỗi tiếp tục, kiểm tra lại nguồn và kết nối 
 

 
Hình 16. Tình trạng nạp thất bại 
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Một trường hợp khác trong khi nạp màn hình Status Bar hiển thị cảnh báo và 
chuyển sang màu vàng như trong Hình 17. Trong trường hợp này, PICkit 2 và 
board mạch đích có thể bị rời ra (mất nguồn hoặc mất kết nối) 
 

 
 

Hình 17. Tình trạng nạp bị cảnh báo 
 
2.7 Automatic File Reload 
 
Trước mỗi lần nạp, thời gian của Flie HEX nhập vào được đánh dấu và so sánh với 
phiên bản trên đĩa. Nếu phiên bản trên đĩa mới hơn, nó được tải trở lại (reload). 
Điều này chỉ thực hiện khi một file HEX được đọc từ đĩa. 
 
Đặc tính này bảo đảm phiên bản xây dựng gần đây nhất sẽ được nạp tới Chip. nó 
có thể được sử dụng bởi Tools>Program on PICkit Button đặc tính để Lập trình 
gần đây nhất MPLAB IDE không chuyển tới phần mếm nạp PICkit 2 mà đơn giản 
bởi việc nhấn PICkit 2 unit push button. 
 
2.8 VERIFYING THE DEVICE 
Chức năng verifyes (xác minh / so sánh) kiểm tra chương trình trong bộ nhớ chip 
có phù hợp với nội dung file HEX imported vào trong PICkit 2 Programmer 
application hay không. Nó so sánh tất cả các vùng của bộ nhớ bao gồm program 
memory, data EEPROM memory , ID và Configuration bits. Để so sánh mã, nhập 
file Hex và click Verify (Hình 18). 
Ghi nhớ sau khi nạp thì sẽ có quá trình tự động được verified nếu 
Programmer>Verify on Write được check. 
 

 
Hình 18. NÚT VERIFY 
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2.9 READING DEVICE MEMORY 
Để xem nội dung trong chip nhấn nút Read (Hình 19) 
 

 
Hình 19. NÚT READ 

Mã được hiển thị trong cửa sổ Program Memory và EEPROM Data cho bạn xem 
tổng quan. Nếu tất cả hiển thị zeros thì có thể thấy rằng chip đã được code-protect 
(bảo vệ mã / khóa chương trình) 
 
2.10 CODE PROTECTING THE DEVICE 
Chức năng bảo vệ Code và Data cho phép bảo vệ đặc tính đọc (Read) chip. Để bảo 
vệ bộ nhớ chương trình (program memory code), cần hoàn thành những bước sau: 

1. Import hex file. 
2. chọn Tools>Enable Code Protect như thấy trong hình 20. 
3. Click Write. 

EEPROM data memory có thể được bảo vệ bằng cách chọn Tools>Enable Data 
Protect. 
 

 
 

Hình 20. ENABLE CODE PROTECT 
 
2.11 ERASING AND BLANK CHECKING THE DEVICE 
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Chức năng Erase Xóa bỏ program memory, ID and Configuration bits, bất chấp 
trạng thái " Enabled " Checkboxes của program memory và data EEPROM 
memory. Để xóa chip, click Erase (Hình 21). 
 

 
Hình 21. NÚT ERASE 

 
Chức năng Blank Check sẽ đọc toàn bộ thiết bị để xác định nếu Program Memory, 
EEPROM Data memory, User IDs và Configuration bits được xóa bỏ hay chưa. 
Tất cả các vùng kí ức sẽ được khảo sát, bất chấp tình trạng của checkbox 
"Enabled" của Program Memory và EEPROM Data memory. 
Để kiểm tra chip trống , click Blank Check (Hình 21). 
 
2.12 AUTOMATING WRITE/READ PROCEDURES 
PICkit 2 Programmer application có hai nút nhấn để tự động hóa nhiều chức năng. 
 

 
 

Hình 22. AUTOMATING BUTTONS 
 

Auto Import Hex + Write Device Button 
Những đặc tính cho phép PICkit 2 Programmer application tự động nhập 
một Flie HEX và nạp tới một Chip được nối khi file hex updated ; chẳng 
hạn, xây dựng Firmware mới. 
 
Để sử dụng đặc tính này, click Auto Import Hex + Write Device. Nó sẽ 
hiện lên một hội thoại chỉ đến file hex nhập vào mới nhất trong file history 
nằm bên dưới Menu File. Saukhi chọn một file, nó sẽ được nạp tới thiết bị. 
PICkit 2 Programme bây giờ sẽ theo dõi file HEX được lựa chọn cho sự cập 
nhật. Khi nào file đó được cập nhật (có thờ gian mới hơn), ứng dụng sẽ tự 
động Re-import file hex này và nạp tới chip. 
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Trong khi đặc tính này được cho phép, những thao tác lập trình khác thì 
mất tác dụng (Disable). Nút Auto Import Hex + Write Device sẽ tích cực 
nếu nó được nhấn xuống. để ngừng sử dụng đặc tính này click Auto 
Import Hex + Write Device một lần nữa. 
 
Nếu một lỗi được gặp trong thời gian nhập vào file HEX hoặc nạp, thì ứng 
dụng sẽ tự động thoát ra kiểu đặc tính này. 
 
Read Device + Export Hex File Button 
Khi được kích, nút này sẽ đọc thiết bị đích và mở hội thoại Export Hex 
File để lưu lại nội dung chip. 

 
 
 
 

Chương 3 
Sử dụng In-Circuit Serial Programming (ICSP) 

 
3.1 giới thiệu 
 
PICkit 2 Development Programmer/Debugger có thể lập trình microcontroller 
devices mà được thiết đặt trong một mạch ứng dụng đang sử dụng In-Circuit 
Serial Programming (ICSP). ICSP yêu cầu 5 tín hiệu: 
 

• VPP – Điện áp lập trình; Khi được áp dụng, chip được đưa vào trạng thái 
lập trình (Programmer – Nạp dữ liệu) 

 
• VDD – Nguồn điện áp dương cấp cho chip 
 
• VSS hay GND – Nguồn đất (0V reference). 
 
• ICSPDAT hoặc PGD - Programming Data; xung đồng bộ 2 chiều serial 

data  
 
• ICSPCLK hoặc PGC - Progamming Clock; một xung đồng bộ một chiều 

serial clock từ thiết bị lập trình (máy nạp) đến Chip 
 

Tuy nhiên mạch ứng dụng phải được thiết kế cho phép các tín hiệu lập trình được 
nối tới thiết bị không có sự méo dạng những tín hiệu lập trình. Hình 3-1 trình bày 
một sơ  đồ điển hình như một điểm xuất phát khi thiết kế một mạch ứng dụng có 
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ICSP. Để lập trình ICSP thành công, những sự đề phòng trong những mục sau đây 
cần tuân thủ 
 

 
Hình 3-1. Mạch ứng dụng cô lập ICSP 

 
 3.2 Cô lập VPP/MCLR/PORT PIN 

Khi VPP được áp dụng, mạch ứng dụng sẽ được cấp nguồn VPP tiêu biểu là 
+12V. điều này có thể xảy ra như sau: 
 
Nếu chân VPP sử dụng như một chân /MCLR: 
Mạch ứng dụng được nối với mạch Pull-up điện trở / tụ điện như đề nghị trong 
datasheet của chip. Điều này phải cần được giữ. Vì vậy điện áp VPP có nhịp độ 
không được làm chậm và không được làm ảnh hưởng đến thời gian tăng trưởng 
trong thuyết minh lập trình (điền hình là 1µs). 
 
Nếu một mạch giám sát hay một nút điều khiển giao tiếp tới chân /MCLR thì 
nó được khuyến cáo cô lập với điện áp VPP bằng diode Schottky hay điện trở 
giới hạn trình bày trong Hình 3-1 
 
Nếu chân VPP sử dụng như một chân I/O Port: 
Nếu mạch ứng dụng sử dụng chân này như một chân I/0 thì nó không có khả 
năng xử lý điện áp +12V. do đó khuyến cáo cô lập với điện áp VPP bằng diode 
Schottky hay điện trở giới hạn trình bày trong Hình 3-1 

Mạch cô lập : 
Điện trở hay Diode kiểu 

Schottky 
 

Đến mạch 
ứng dụng 

* Giá trị tham khảo 
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 3.3 Cô lập Các chân PGC và PGD 
PGC và PGD cần được cô lập với mạch ứng dụng để khỏi ảnh hưởng đến tín 
hiệu lập trình . PGC là một đường xung clock nối tiếp một chiều đi từ bộ nạp 
đến chip, PGD là đường truyền dữ liệu nối tiếp 2 chiều. 
 
Nếu thiết kế cho phép, nên dành những chân này cho ICSP, tuy nhiên nếu 
mạch ứng dụng yêu cầu những chân này phải sử dụng trong mạch ứng dụng, 
thì thiết kế mạch sao cho không làm thay đổi mức và nhịp độ của tín hiệu. 
mạch cô lập có thể sẽ thay đổi theo từng ứng dụng. Hình 3-1 cho thấy một khả 
năng sử dụng những điện trở để cô lập tín hiệu ICSP từ mạch ứng dụng 
 

 3.4 VDD 
Trong thời gian lập trình ICSP, thiết bị cần cung cấp nguồn phù hợp với thuyết 
minh thiết bị. Điển hình, điện áp cung cấp cho Chip được kết nối tới điện áp 
cung cấp bởi mạch ứng dụng. Mạch ứng dụng có thể dùng nguồn bởi PICkit 2 
hay nguồn ngoài. 
 
Có vài sự đề phòng mà cần quan sát trong những hoàn cảnh được bao gồm 
trong sự theo sau ba mục 
 
3.4.1 Mạch ứng dụng cấp nguồn bởi PICKit 2  
Điện áp cung cấp PICkit 2 có thể đặt giữa cực đại và những điện áp cực tiểu 
cho phép bởi thuyết minh lập trình thiết bị, trừ phi cực tiểu ở dưới là+2.5 V. 
Chắc chắn để đặt điện áp thiết lập trong Voltaget Box tới điện áp thích hợp 
trước đây lập trình thiết bị hay việc bật On VDD . 

 
Nhắc nhở: Dòng giới hạn của cổng USB được set đến 100 mA, nếu dòng của 
mạch đích + dòng của PICKit 2 vượt quá dòng giới hạn này thì cổng USB có 
thể bị ngắt. Mạch đích có thể sử dụng nguồn ngoài nếu nó yêu cầu dòng cao 
hơn. 

 
3.4.2 Mạch ứng dụng cấp nguồn ngoài  
PICKit 2 có thể sử dụng với những mạch ứng dụng cung cấp nguồn ngoài giữa 
+ 5.0V và +2.5V 

 
3.4.3 sử dụng xóa gộp (Bulk Erase) 
Một số thiết bị sử dụng một chức năng xóa gộp để xóa bỏ program memory, 
data EEPROM memory, ID locations, và Configuration bits. Điển hình, xóa 
gộp vận hành yêu cầu một điện áp cung cấp VDD 4.5 tới 5.5V.  
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Phạm vi điện áp này có thể là một vấn đề nếu mạch ứng dụng được thiết kế để 
vận hành tại một phạm vi điện áp cung cấp khác nhau. Trong lệnh xóa gộp để 
xóa thiết bị, mạch ứng dụng cần phải xem xét yêu cầu điện áp xóa gộp trong 
khi bảo vệ bất kỳ mạch dò điện áp nào. 

 
Nếu điện áp xóa gộp dưới mức cực tiểu, một hộp thoại sẽ cảnh báo người sử 
dụng thử xóa thiết bị trước khi nạp. 
 

 3.5 VSS 
Chính là GND được kết nối đến như tên gọi của nó đến mạch ứng dụng 
 

 3.6 Độ Dài Của Cáp 
Nên tối thiểu chiều dài của cáp ICSP mục đích giữ cho những tín hiệu ICSP 
không bị ảnh hưởng đến mức và nhịp độ của tín hiệu 
 

 

Chương 4  
PICkit 2 Debug Express 

   
4.1 GIỚI THIỆU 
Ngoài ứng dụng Nạp chương trình (Programmer), PICkit 2 Development có thể 
được sử dụng để Nạp/ Gỡ rối với MPLAB IDE , MPLAB IDE cho phép PICkit 2 
được sử dụng như một in-circuit debugger as well as a programmer(chỉ cho những 
thiết bị được lựa chọn). 
 
In-circuit debugger cho phép bạn chạy, khảo sát và sửa đổi chương trình của mình 
trong khi chip nắm trong phần cứng đích. Điều này rất giúp bạn rất nhiều trong 
việc gỡ lỗi vi chương trình (Firmware) và phần cứng (Hardware) cùng nhau. 
 
Đặc biệt phần mềm PICkit 2 Debug Express tương tác với MPLAB IDE 
application để chạy (run), dừng (stop) và chạy từng bước (single-step). Một hoặc 
nhiều điểm dừng có thể được sử dụng và bộ xử lý có thể Reset lại. Một lần bộ xử 
lý dừng lại, nội dung của thanh ghi có thể được khảo sát và thay đổi. 
 
Để biết chi tiết hơn về cách sử dụng MPLAB IDE, tham khảo các tài liệu sau: 

• MPLAB® IDE User.s Guide (DS51519) 
• MPLAB® IDE Quick Start Guide (DS51281) 
• MPLAB® IDE On-line Help 

 
4.2 CÀI ĐẶT PHẦN CỨNG VÀ PHẦN MỀM 
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Cài đặt Phần cứng PICkit 2 Như được chỉ rõ trong hướng dẫn sử dụng PICkit 2 
 
Lưu ý: Trong một số tài liệu và phần cứng cũ của Microchip có đề nghị sử dụng 
điện trở pull-down 4,7KΩ trên các chân ICSPCLK và ICSPDAT cho debugger. 
PICKit 2 mới của Microchip và của TMe đã có sẵn các điện trở này bên trong vì 
vậy không cần sử dụng thêm các điện trở này trên board mạch đích. 
 
Cài đặt phần mềm ứng dụng MPLAB IDE lấy từ website của microchip hoặc trong 
đĩa CD_ROM kèm theo, và cài đặt nó theo định hướng của phần mềm. 
 
Lưu ý: Debug Express yêu cầu phiên bản MPLAB IDE 7.50 hoặc mới hơn 
 
 
4.3 SỬ DỤNG PICKIT 2 DEBUG EXPRESS 

 
4.3.1  Xác định Device Support 

 
Một danh sách cho các chip hiện thời được hỗ trợ bởi PICkit 2 Debug Express, 
xem file “Readme for PICkit 2.htm” nằm trong thư mục con “Readmes” của thư 
mục cài đặt MPLAB IDE 
 
Khi Lựa chọn một thiết bị như được nói đến trong mục 4.5 “Debug Express 
Tutorial” ,Hộp thoại “Select Device” cho thấy trong Hình 4-11 hiện ra mức độ hỗ 
trợ cho thiết bị được chọn bởi Debugger Express. Trong mục của hộp thoại 
“Debugger”, màu của hình tròn tại vị trí “PICkit 2” cho thấy mức độ hỗ trợ : 

• Màu Đỏ - Thiết bị hiện chưa được hỗ trợ bởi PICkit 2 Debug Express  
• Màu vàng - Thiết bị có sự hỗ trợ beta bởi PICkit 2 Debug Express 
• Màu Xanh lục - Thiết bị có đầy đủ hỗ trợ bởi PICkit 2 Debug Express 

Chỉ báo sự hỗ trợ Beta là chỉ báo thiết bị được hỗ trợ, nhưng chưa được kiểm 
chứng với sự thử của Microchip. 
 
 4.3.2  Tài nguyên dự trữ 
Vì các thiết bị có khả năng ICD xen kẽ chức năng in-circuit debugging và chức 
năng ICSP trong quá trình debugging, nên PICkit 2 Debug Express sử dụng một số 
tài nguyên on-chip trong khi debug, những vùng (vị trí) này không sẵn sàng cho sự 
sử dụng cho mã người dùng. Trong MPLAB IDE những thanh ghi được gắn mác 
“R” trong cửa sổ Register là đại diện cho những thanh ghi dự trữ 
Để biết thông tin về tài nguyên thiết bị cần cho in-circuit debugging vui lòng xem 
trong MPLAB ICD2 Help, tìm trong help� topic. Tài nguyên sử dụng trong 
MPLAB ICD2 thì cũng giống như trong PICkit 2 Debug Express. 
 
4.3.3 Sử dụng ICSP Header 
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Hình 4.2 Nối demo board đến PICkit 2 

 
4.3.4 Configuration Bits and Debug Express 
 
PIC microcontroller devices không yêu cầu một ICD Header và có thể được gỡ lỗi 
trực tiếp bằng #DEBUG bit trong Configuration Word(s). Điều đó cho phép hoặc 
loại bỏ chế debugger của PIC Microcontroller. 
Bit này được tự động thiết lập cho phù hợp bởi MPLAB IDE khi sử dụng PICkit 2 
Debug Express và không nên được chỉ rõ trong source code configuration settings. 
 
NHẮC NHỞ: 
Ở những điều kiện thiết đặt bình thường giá trị DEBUG configuration bit Không 
nên được chỉ rõ trong Cấu hình mã nguồn. Vì vậy có thể gây ra bit  sẽ được khẳng 
định Khi việc lập trình một thiết bị bên ngoài trình gỡ rối. Cái này sẽ gây ra thiết 
bị vận hành không thích hợp hay không đúng với mong muốn trong mạch ứng 
dụng. 
 
Nhiều chip 16-bit PIC microcontroller chẳng hạn như họ PIC24 và dsPIC33 có 
nhiều chân ICSP Programming và debugging port pins nhãn PGC1/EMUC1 và 
PGD1/EMUD1, PGC2/EMUC2 và PGD2/EMUD2, vv. Trong khi bất kỳ cổng 
ICSP nào cũng có thể sử dụng để lập trình (nạp), chỉ có một cổng tích cực trong 
thời điểm debugging 
 
Để kích hoạt EMU port thiết lập trong device Configuration bits. Nếu kích hoạt 
thiết lập không phù hợp Emu port nối tới PICkit 2, thì thiết bị không có khả năng 

PIC MCU có thể được debugged 
trực tiếp qua đầu nối ICSP (In 
Circuit Serial-Programming) mà 
không cần ICD Header 
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vào chế độ debug. Trong hộp thoại Configuration Bits của MPLAB IDE, bit này 
thường được tham khảo tới như “Comm Channel Select” bits. 
 
4.3.5 Debug Express Breakpoints (điểm dừng) 
  
Số lượng breakpoint kích hoạt được PICkit 2 Debug Express hỗ trợ phụ thuộc vào 
thiết bị đích, đa số Baseline và Mid-Range devices hỗ trợ 1 breakpoint, một số 
PIC18 và 16-bit được hỗ trợ nhiều breakpoints hơn 
Số điểm dừng tích cực sẵn có cho thiết bị hiện thời trong MPLAB IDE có thể 
được nhìn thấy bởi lựa chọn “Debugger>Breakpoints”. Cái này sẽ mở một hội 
thoại (Hình 4-3) cho thấy bất kỳ điểm dừng hiện thời được đặt nào trong Kí ức 
Chương trình (Program Memory). “Active Breakpoint Limit:” hộp văn bản cho 
thấy tổng bao nhiêu điểm dừng sẵn sàng cho thiết bị hiện thời. “Available 
Breakpoints:” hộp văn bản cho thấy tổng bao nhiêu điểm dừng cho thiết bị hiện 
thời không sử dụng 

 
Hình 4-3 Hội thoại những điểm dừng (cho) PIC16F887 
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Một số PIC18 Và 16- bits cũng hỗ trợ những advanced breakpoints (advanced 
breakpoints). Những advanced breakpoints cho phép những điểm dừng được thiết 
lập trong File Register memory, và sẽ dừng sự thực hiện khi một File Register đặc 
biệt được đọc hay ghi tới. Điểm dừng này có thể cũng được thiết lập sao cho nó sẽ 
chỉ dừng khi một giá trị đặc biệt được đọc từ hay ghi tới một thanh ghi. Đồng thời, 
một “Pass Count” có thể thiết lập bất kỳ kiểu điểm dừng nào. Pass count này số 
của những lần điểm dừng quy định mà nó gặp trước đây ngưng thực hiện (halt 
execution). Chẳng hạn, thiết lập pass count là “2” điểm dừng trên một Program 
Memory có nghĩa rằng chỉ dẫn sẽ thực hiện hai lần không có việc dừng sự thực 
hiện, và thời gian một phần ba chỉ dẫn được thực hiện điểm dừng sẽ dừng sự thực 
hiện. Mặc định pass count cho tất cả các điểm dừng là “0”, có nghĩa rằng sự thực 
hiện sẽ dừng lần đầu điểm dừng được gặp. Nếu những advanced breakpoints được 
hỗ trợ bởi thiết bị hiện thời, thì MPLAB IDE menu option Debugger>Advanced 
Breakpoints sẽ sẵn sàng mở một hộp thoại advanced breakpoint, nếu thiết bị không 
hỗ trợ advanced breakpoints thì menu option sẽ mờ đi xem như không có. Lựa 
chọn điểm dừng có thể soạn thảo trong hộp “Break Point #”  
 

 
 

HÌNH 4-4 ADVANCED BREAKPOINTS DIALOG 
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Ghi chú: 
Hộp thoại Advanced breakpoints sẽ trình bày bất kỳ Điểm dừng nào thiết lập 
trong Program Memory. Tuy nhiên, hộp thoại có thể không sử dụng để đặt hay 
xóa những điểm dừng trong Program Memory hay để soạn thảo địa chỉ (của) một 
Điểm dừng Program Memory hiện hữu. Chỉ giá trị Pass Count cho điểm dừng 
Program Memory được có thể soạn thảo trong hội thoại Advanced breakpoints. 
Để soạn thảo, thiết đặt hoặc xóa những điểm dừng Program Memory, sử dụng 
MPLAB IDE Editor hay menu Debugger>Breakpoints…  
 
4.3.6 Breakpoint Skidding (Điểm dừng trượt) 
 
The in-circuit debug implementation on PIC microcontrollers will halt execution 
on the instruction after the breakpoint instruction. This means the breakpoint 
instruction will have executed when the debugger halts. This is referred to as 
“breakpoint skidding”. 
As a result, there are some breakpoint behaviors to be aware of. When a 
breakpoint is set on a GOTO, CALL, or RETURN instruction, the debugger will 
halt at the destination instruction, as the program branch instruction with the 
breakpoint will have executed. Also, when using the debugger Step Over function, 
a breakpoint will be set on the instruction after the CALL instruction that the 
debugger is “stepping over” if there is an available breakpoint. If the CALL 
instruction is followed immediately by another CALL instruction, this will result 
in the debugger halting at the destination of the second CALL instruction. To 
prevent this, a NOP may be placed between the CALL instructions. 
Note that 16-bit devices will halt two instructions after the breakpoint instruction. 
 
4.3.7 Linker Scripts 
 
Nếu project của bạn sử dụng một linker script, files ICD linker script đặc biệt phải 
được sử dụng khi debugging mà những tài nguyên dự trữ được sử dụng bởi PICkit 
2 Debug Express. Mỗi chip có chứa một separate debug linker file, có kí tự “i” ở 
cuối tên chip đó  
Chẳng hạn: 

16F877i.lkr . In-Circuit Debug linker file for the PIC16F877 device 
18F4520i.lkr . In-Circuit Debug linker file for the PIC18F4520 device 

Khi việc gỡ lỗi với PICkit 2 Debug Express , ICD linker file cần phải được sử 
dụng thay vào linker file chuẩn. 
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4.4 HƯỚNG DẪN DEBUG EXPRESS 
 
Hướng dẫn này sử dụng với một board Demo chứa PIC16F887 microcontroller. 
Board demo này được nối với PICkit 2 debug express KIT qua đường ICSP. 
 
Nếu bạn không có board demo bạn cũng nên đọc qua phần hướng dẫn này để có 
cái nhìn tổng quan về việc sử dụng PICkit 2 như một trình gỡ rối trong MPLAB 
IDE. 
 
File nguồn được sử dụng cho hướng dẫn này được cài đặt chung với PICkit 2 
Programmer software. 
 
4.4.1 Selecting the Device (Chọn chip) 
 
Để chọn chip trong MPLAB IDE: 

1. Chạy chương tình ứng dụng MPLAB IDE  
2. từ MPLAB IDE menu bar chọn Configure>Select Device (Hình 4-5). 
 

 
Hình 4-5: MPLAB IDE Menu Bar 
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3. Trong hộp thoại Select Device (Hình 4-6) nhấn vào nút cuộn xuống trong 
hộp Device và chọn chip bạn cần trong list này. Trong hướng dẫn này, chọn 
PIC16F887 

 

 
 

Hình 4-6 SELECT DEVICE DIALOG 
 

4. Không có thay đổi gì khác trong hộp thoại này, Nhấn OK 
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4.4.2 Chọn PICkit 2 như một Công Cụ Gỡ Lỗi 
 
1. Chọn Debugger>Select Tool>PICkit 2. MPLAB IDE sẽ thêm PICkit 2 

debug features (hình 4-7): (A) thanh trạng thái sẽ hiện ra PICkit 2 như công 
cụ gỡ lỗi , (B) Một PICkit 2 debug toolbar sẽ được thêm vào, (C) Debugger 
menu sẽ thay đổi để thêm những chức năng gỡ lỗi cho PICkit 2 và (D) cửa 
sổ Output  sẽ trình bày tình trạng giao tiếp giữa  PICkit 2 và board mạch 
đích trên PICkit 2 tab. 

 
 

 
 

Hình 4-7 PICkit 2 Debug Tool 
 

2. Chọn Debugger>Settings để thiết lập cho PICkit 2. Chắc chắn “Connect on 
Startup” checkbox phải được đánh dấu để cho phép đặc tính tự động kết nối 
feature (Hình 4-8). Rồi nhấn OK. 

 

A 

B 

C 

D 
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Hình 4-8 SETTINGS DIALOG 
 

3. Nếu PICkit 2 không tự động kết nối khi nó được lựa chọn như một công cụ 
gỡ lỗi, bây giờ Chọn Debugger>Connect để kết nối. Tình trạng kết nối sẽ 
hiện ra trong cửa sổ Output. Tùy thuộc vào phiên bản của phần mềm 
MPLAB IDE hoặc Chip được lựa chọn, một thông báo có thể xuất hiện chỉ 
báo Firmware (PICkit 2 operating system) Cần cập nhật. MPLAB IDE sẽ tự 
động cập nhật firmware mới. 

 
4.4.3 Tạo một MPLAB IDE Project 
Một MPLAB IDE Project và không gian làm việc sẽ lưu giữ tất cả file và thiết đặt 
cho cùng một dự án phát triển. Project Wizard sẽ giúp bạn thiết lập một project 
mới. 

Select Project> to set up the project. The screen will display (Figure 4-9). 
Click Next to continue to Step One.  

1. Chọn Project > Project Wizard để thiết lập project. Sẽ hiện ra màn hình 
Project Wizard Welcome (Hình 4-9). Kích Next để tiếp tục bước 1. 
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Hình 4-9 PROJECT WIZARD WELCOME 
 

2. Chọn Chip PIC16F887 tử “Device” drop-down box, nếu nó chưa được 
chọn (Hình 4-10). Click Next để tiếp tục bước 2. 
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Hình 4-10 BƯỚC 1 – CHỌN CHIP 
3. Cho project này, MPASM assembler tool sẽ được sử dụng. chọn 

“Microchip MPASM Toolsuite” từ Active Toolsuite drop-down menu 
(hình 4-11). Chắc chắn rằng các tool được set theo mặc định trong folder 
sau:  C:\Program Files\Microchip\MPASM Suite: 

- MPASM assembler cần phải đang trỏ vào mpasmwin.exe. 
- MPLINK. object linker cần phải đang trỏ vào mplink.exe. 
- MPLIB. object librarian cần phải đang trỏ vào mplib.exe. 

Click Next để tiếp tục sang bước 3 
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HÌNH 4-11: BƯỚC 2 - CHỌN BỘ NGÔN NGỮ LẬP TRÌNH 
 
4. Click Browse (Hình 4-12) để định vị hay tạo ra một thư mục project dự án 

mới và tên project. trong hướng dẫn này, chọn vị trí C:\Program 
files\Microchip\PICkit 2 v2\DBE Demo và đặt tên cho project, ví dụ như 
“PIC16F887 Debug Demo” 



PICKIT2 User’s Manual                                                                    Trang 38 of 50 
 
 

 

 

 

Thien Minh Electronic Solutions Co.Ltd (TMe) www.tme.vn 
 

 
 

HÌNH 4-11: TẠO MỘT PROJECT MỚI 
 

5. Thêm một file nguồn cho project (Hình 4-13) từ cửa sổ bên trái đi đến 
C:\Program Files\Microchip\PICkit 2 v2\DBE Demo. Chọn và bật sáng 
file 16F887demo.asm và nhấn Add. File này sẽ được đặt vào trong cửa sổ 
bên phải 
Ghi chú: những file khác có thể bổ sung sau đó. 
Dấu “A” trong hình 4-13 cho phép MPLAB IDE quyết định đường dẫn tới 
file là tương đối hay tuyệt đối cho project. Để biết mô tả và cách thay đổi 
những kiểu thêm file có thể xảy ra trong tài liệu  của MPLAB IDE. Không 
thay đổi thiết đặt cho Project này. Click Next để tiếp tục sang cửa sổ tóm 
lược. 
Ghi chú: với những project chứa nhiều file assembly (ví dụ Multifile 
project, C code project)  bạn sẽ cần thêm một linker script file. Xem tài 
liệu công cụ ngôn ngữ cho thấy nhiều chi tiết hơn. 
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HÌNH 4-13 BƯỚC 4 – THÊM FILE 
 

6. Nếu có lỗi trong khi làm, nhấn Back để trở lại bất kỳ thao tác nào trong 
Project Wizard (Hình 4-14) nếu không nhấn Finish 
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Hình 4-14 FIGURE PROJECT WIZARD SUMMARY 

 
4.4.4 Xem Demo Project 
Sau khi hoàn thành một project và thoát ra khỏi Project Wizard, cửa sổ Project sẽ 
trình bày trong MPLAB IDE desktop window (Hình 4-15). Nếu nó không mở ra 
thì chọn View>Project để mở nó lên. 
 
Khi cần, những file project có thể thêm vào hoặc loại bỏ bớt từ Project Window. 
Nhấn phím phải của chuột vào file trong Project Window để hiện ra pop-up menu 
với những tùy chọn, ở đó có thể thêm hoặc bỏ bớt file. 
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HÌNH 4-15 PROJECT WINDOW FILE MENU 

 
4.4.5 Tạo ra một File HEX 
Để tạo ra một file HEX để nạp vào Chip, bạn cần phải Build project này. Chọn 
Project>Build All hoặc right click vào tên project trong Proect Window và “Build 
All” từ pop-up menu MPASM assembler sẽ tạo ra một file HEX có tên trùng với 
tên của file .asm. Diễn tiến của quá trình sẽ rõ ràng trong thẻ Build của output 
window (Hình 4-16) 
 

 
 

HÌNH 4-16: OUTPUT WINDOW . BUILD THE PROJECT 
 
 
4.4.6 Kiểm tra giá trị Configuration Bit 
 
Những Configuration bit sẽ được nạp và bên trong Chip là được set từ chương 
trình sử dụng chỉ thị _CONGIF. Một Project được xây dựng, những giá trị của 
những bits này có thể được xác minh sử dụng Config Bit Window chọn 
Configure>Configuration Bits (Hình 4-17). 
 
Những Congif bits sau đây được sử dụng trong hướng dẫn này: 

Config1: 
• Oscillator - Internal RC No Clock 
• Watchdog Timer - Off 
• Power-Up Timer - On 
• Master Clear Enable - MCLR is external 
• Code-Protect - Off 
• Data EE Protect - Off 
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• Brown-Out Detect - BOD and SBOREN Disabled 
• Internal-External Switch Over Mode - Disabled 
• Monitor Clock Fail-safe - Disabled 
• Low-Voltage Program – Disabled 
 
Config 2: 
• Self Write Enable . No Protection 
• Master Brown-out Reset Sel Bit . Brown-out at 2.1V 

 

 
 

HÌNH 4-17 CONFIGURATION BIT SETTINGS 
 
4.4.7 Tải mã chương trình để Debugging 
 
Để nạp cho Chip, chọn Debugger>Program để nạp file 16F887demo.hex vào Chip 
16F887 trên board demo. 
 
Việc nạp Chip chỉ mất vài giây, trong quá trình nạp thẻ PICkit 2 của cửa sổ 
Output sẽ hiển thị những dòng các thao tác đã thực hiện. Đến khi nạp đầy đủ thì 
hộp thoại cần phải nhìn tương tự như hình 4-18 
 
Ghi chú: Khi chạy debug thì code sẽ tự động nạp vào trong bộ nhớ chương trình 
(program memory) của PIC16F887 (Chip đích) khi PICkit 2 được chọn như một 
debugger. Debug code thì được nạp vào trong Chip đích để sử dụng những khả 
năng in-circuit debugging của PICkit 2 
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HÌNH 4-18 OUTPUT WINDOW – NẠP CHIP CHO DEBUG 
 

4.4.8 Chạy PIC16F887 debug demo 
 
The PICkit 2 Debug Express thực hiện chương trình trong thời gian thực (real-
time Run) hặc chạy từng bước (Step Into, Step Over, Step Out, Animate.) chạy 
thời gian thực xảy ra khi bạn chọn Run trong MPLAB IDE. Khi chương trình 
được dừng bởi cả 2 thao tác Halt hoặc breakpoint (Điểm dừng), bạn có thể đi từng 
bước thông qua mã. 
 
Những nút sau đây có thể thường sử dụng cho việc truy nhập nhanh khi thao tác 
debug: 
 

Debugger Menu Toolbar Buttons 

Run  

Halt  

Animate  

Step Into  
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Step Over  

Step Out  

Reset  
 
 
Để chạy Demo code: 
 

1. Double click lên file 16F887Demo.asm từ Project window hoặc chọn 
File>Open từ toolbar menu. Code sẽ hiện ra một cửa sổ file này. 

2. chọn Debugger>Run Hoặc click Run. 
3. xoay biến trở  (RP1), được gắn trên demo board, và quan sát LEDs. 

Nếu chương trình hoạt động đúng thì các led sẽ chạy nhanh hay chậm hơn 
tùy thuộc vào chiều và vị trí của RP1, tuy nhiên có một “bẫy” cố ý đặt trong 
mã với mục đích trình diễn cho debug. Xem mục 4.5.9 “Debugging the 
PIC16F887 Debug Demo Code” cho chỉ dẫn cách gỡ lỗi. 

4. chọn Debugger>Halt hoặc click Halt để ngưng chạy chương trình. Một 
mũi tên màu xanh sẽ đánh dấu vị trí dòng code trong của sổ file khi chương 
trình dừng 

5. chọn Debugger>Reset>Processor Reset để khởi động chương trình. Mũi 
tên biến mất, có nghĩa thiết bị đã được Reset lại. 

 
4.4.9 Debugging the PIC16F887 Debug Demo Code 
 
Bất kỳ những vấn đề sau đây co thể làm PIC16F887 làm việc không đúng 
 

1. Giá trị A/D converter không được viết đúng mức đến delay routine. 
2. A/D converter không được chọn (enable) hay không thiết lập chuyển đổi. 
3. Một lỗi đánh máy trong chương trình có thể gây ra chương trình vận hành 

không thích hợp. 
 
Để khám phá vấn đề được liệt kê đầu tiên, đặt một điểm dừng tại dòng của code 
mà nó ghi tới giá trị A/D kết quả high-oder delay byte: 
 

1. Đặt một con trỏ trên hàng sau đây trên dòng của code trong file 
16F887demo.asm: movwf delay+1 nhìn thấy như hình 4-19. Tại điểm dừng 
này, chương trình sẽ dừng lại một lần khi A/D biến đổi hoàn thành. 

2. Right click 2 lần lên dòng đó để hiện ra drop-down menu và chọn 
“Breakpoint” hoặc double click lên dòng một kí tự breakpoint sẽ xuất hiện 
tiếp đến dòng như chữ B trong hình tám cạnh màu đỏ như nhìn thấy trong 
hình 4-19 
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HÌNH 4-19: SET BREAKPOINT 
 

3. Chọn Debugger>Run, hoặc click Run để chạy chương trình. Điểm dừng sẽ 
dừng chương trình lại khi chương trình chạy đến dòng có đánh dấu như một 
điểm dừng 
 
Ghi chú: tùy thuộc vào Chip , điểm dừng có thể “trượt” qua khỏi vị trí định 
vị, trong trường hợp này nó sẽ dừng tại dòng : 
 
incfsz Delay,f 
 

4. đưa muose qua ADRESH trong dòng trên điểm dừng và nó sẽ hiển thị giá 
trị của file register (Hình 4-20). 
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HÌNH 4-20 GIÁ TRỊ THANH GHI ADRESH 
 

5. Điều chỉnh biến trở RP1 và tiếp tục chạy chương trình bằng cách chọn 
Debugger>Run chương trình sẽ chạy vòng qua và dừng lại lần nữa. 

6. Đưa mouse qua ADRESH lần nữa và xem kết quả A/D không hề thay đổi. 
Như vậy là hình như biến đổi A/D không làm việc. bộ biến đổi A/D được 
khởi tạo và cài đặt xảy ra ở đầu chương trình. 

7. chọn Debugger>Reset để reset lại chương trình 
Select View>Watch to open a new Watch window. This window will allow you to 
watch the A/D register value change as the program executes. The Watch dialog 
opens with the Watch 1 tab selected, as shown in Figure 4-21. 

 
8. Chọn View>Watch để mở một cửa sổ Watch, cửa sổ này cho phép bạn đi 

tới thay đổi giá tri thanh ghi A/D như chương trình đang chạy. Hộp thoại 
Watch mở ra có một bảng chọn Watch 1 như trình bày trên hình 4-21  

 

 
 

HÌNH 4-21 NEW WATCH WINDOW 
 

Ghi chú: Nó không đề nghị sử dụng cửa sổ View>File Registers và View>Special 
Function Registers khi gỡ lỗi với PICkit 2 Debug Express. Khi cửa sổ này mở, 
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toàn bộ nội dung được ghi rồi đọc lại từ chip đích trong mọi thao tác, điều này làm 
chậm quá trình debug một cách đáng kể. Thay vào đó, chỉ thêm SFR và biến file 
Register mà ta quan tâm đến cửa sổ Watch như được mô tả trong phần hướng dẫn 
này. 

 
9. chọn ADCON0 từ đầu danh sách sổ xuống và click Add SFR để thêm 

ADCON0 vào cửa sổ Watch. Lặp lại điều này để thêm ADCON1 và 
ADRESH vào cửa sổ Watch. FSRs được lựa chọn thì cần phải rõ ràng như 
trong hình 4-22 

 

 
 

HÌNH 4-22 THÊM SFRs VÀO CỬA SỔ WATCH 
 

10. Chọn Debugger>Run để chạy chương trình lần nữa, chương trình sẽ dừng 
lại sau khi nó đến vị trí điểm dừng. 

11. Khảo sát những giá trị ADCON0 và ADCON1 trong cửa sổ Watch, giá trị 
ADCON0 là “0x40” ( b’01000000’). Giá trị này tương ứng với giá trị hex 
được chỉ định trong chương trình, tuy nhiên đây thì không đúng. Xem lại 
“PIC16F882/883/884/886/887 Data Sheet”  (DS41291), mục Analog – to 
– Digital (A/D) module, chỉ báo cuối cùng của bit này là “1”  
(b’01000001’) để bật module A/D. để cố định cái nhiễu này, thay đổi:  
movlw 0x40 
Thành  
movlw 0x41 trình bày như hình 4-23 
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HÌNH 4-23: AD MODULE CODE 
 
12. Chọn file>save để lưu sự thay đổi của bạn 
13. bạn phải build lại và nạp lại cho Chip để thay đổi hiệu ứng. Chọn 

Project>Build All để xây dựng lại project và Debugger>Program để nạp 
lại cho Chip sử dụng PICkit 2 

14. Chọn Debugger>Run để chạy chương trình lần nữa, chương trình sẽ dừng 
lại sau khi nó đến vị trí điểm dừng. 

15. Khảo sát những giá trị trong cửa sổ Watch, bây giờ, giá trị ADCON0 cần 
phải là “0x41” (Hình 4-24). 

 
 

HÌNH 4-24 GIÁ TRỊ ĐÚNG ADCON 
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16. Right click trên dòng của code có đán dấu điểm dừng, và chọn 
Remove>BreakPoint hoặc double click trên dòng đó để gỡ bỏ điểm dừng. 

17. Chọn Debugger>Run để chạy chương trình thời gian thực, xoay biến trở 
RP1 để thay đổi giá trị hiển thị trên LEDs, Bây giờ nó đã làm việc. 

 
Mã nguồn trong hướng dẫn này chứa đựng chỉ một bẫy. Tuy nhiên, mã thực sự có 
thể có nữa. Sử dụng MPLAB IDE với chức năng debug của PICkit 2 một cách 
thành công, bạn có thể tìm thấy và fix những vấn đề trong code của các bạn. 
 
4.4.10 Ứng dụng Lập trình và Gỡ lỗi 
Khi chương trình thành công được gỡ lỗi và chạy, bước tiếp theo là nạp chương 
trình vào chip và chạy độc lập trong khi kết thúc thiết kế. Khi làm điều này, những 
tài nguyên dự trữ bởi ICD được thả tự do cho sử dụng bởi ứng dụng. để nạp 
chương trình ứng dụng, sử dụng những bước sau: 

1. Bỏ chọn PICkit 2 như một công cụ debug bằng cách chọn Debugger>Select 
Tool>None 

2. Chọn PICkit 2 như một công cụ nạp trong menu Program>Select 
Programmer 

3. Lựa chọn: Thiết lập ID trong Configure>ID Memory (Hình 4-25) 
 

 
 

HÌNH 4-25 SỬ DỤNG ID MEMORY 
 

4. Thiết lập những thông số để lập trình trên Programmer>Settings , Bảng 
chương trình 

5. Chọn Programmer>Program 
 
Bây giờ Chip đích sẽ chạy độc lập 
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Chúc bạn thành công! 
 
 

 

 
 
 

Xin chân thành cảm ơn bạn đã sử dụng sản phẩm của chúng tôi. 
 
Chúng tôi luôn hoan nghênh các bạn có những ý kiến đóng góp để chúng tôi ngày 
càng hoàn thiện hơn và phục vụ các bạn tốt hơn. 
 
Nếu bạn cần bất kỳ thông tin nào liên quan đến sản phẩm của chúng tôi. Hoặc bạn 
muốn hợp tác tiêu thụ / mua hàng. Xin vui lòng liên hệ: 
http://www.tme.vn/Contact.aspx hoặc: 
 
 Công Ty TNHH Giải Pháp Điện Tử THIÊN MINH (TMe) 

(Thien Minh Electronic Solutions Co,ltd) 
 Địa chỉ:     226 Tân phước, F.6, Q.10, Tp.HCM 
 Điện thoại: 08.39573224  
 Fax:   08.6264 3029 
Web-site:  www.tme.vn  
 Email:      Bán hàng: sale@tme.com.vn 

                    Hỗ trợ kỹ thuật: support@tme.com.vn  
                   web Admin: tminh@tme.com.vn 
 Giờ làm việc: 7h30 đến 17h30 thứ 2 đến thứ 7 hàng tuần (chủ nhật nghĩ)                                   

 
 
 
Cập nhật: TPHCM tháng 01/2013 
 
 

 


